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PHOTOSHOP CS5 EXTENDED CAƧC CÔNGCUƥ  
 
BÀI 1 NGÀY 22.5.2011 ÚT BỈNH SOẠN 
 

 
TÁC GIẢ KỶ SƢ NGUYỄN VIÊƥ T DŨNG  VIÊƧT RÂƧT NHIÊƦU SAƧCH TIN HOƥ C , HÂƦU HÊƧT CAƧC BÔƥ  MÔN 
BẠN ĐỀU THẤY XUẤT BẠN . TÂƧT CAƤ  SAƧCH NAƦY DAƦY VAƦ  VIÊƧT RÂƧT CHI TIÊƧT , TỈ MĨ , ĐOƥ C DÊ ̃DAƦNG 

LÃNH HỘI ĐƢỢC HÂƦU HÊƧT. ÚT BỈNH ĐOÁN CÓ LẺ TÁC GIẢ MUỐN DÀI HƠI DỊCH VÀ XUẤT BẢN BỘ 
MÔN PHOTOSHOP, MÔƥ T NGAƦNH RÂƧT HÂƧP DẪN TRONG TIN HOƥ C NÊN CHO RA QUYÊƤ N 1 DÂƦY 640 

TRANG NĂM 2004 RÔƦ I KHÔNG THÂƧY QUYÊƤ N 2. (Bạn nào biết có quyển 2 xin baƧo cho Út Bỉnh biết. 
Cám ơn). 
ÚT BỈNH TUỔI ĐÃ LỚN GẦN 65 RÔƦ I, MUÔƧN DUƦNG TAƦI HEƦN SƢƧC MOƥ N TÔ VEƤ  LAƥ I QUYÊƤ N SAƧCH ĐĂƧC 

Ý NÀY TRÊN NÊƦN CHƢƠNG TRIƦNH PHIÊN BAƤ N MƠƧ I NHÂƧT LAƦ  PHOTOSHOP CS 5 THÀNH MỘT QUYỂN 
SÁCH DIỄN GIẢI THÊM  CÓ MÀU SẮC VÀ TRÌNH BÀY HẤP DẪN LÔI CUỐN  CHO CAƧC EM HAM TIƦM 

HIÊƤ U VÊƦ PHOTOSHOP NHƢNG TRIƦNH ĐÔƥ  ABC TIN HOƥ C CŨNG LÃNH HÔƥ I ĐƢƠƥ C VAƦ  YƧ MUÔƧN LAƦM 
ĐƢỢC MÔƥ T VIÊƥ C HƢ̃U IƧCH TRONG CUÔƥ C ĐƠƦ I CUƤ A UƧT BIƤ NH. 
 

Sách Adobe Photoshop CS cuƤ a NGUYỄN VIÊƥ T DŨNG xuâƧt baƤ n 2004 có đính kèm Dỉa Dữ 
Liêƥ u đêƤ  thƣƥ c tâƥ p , gôƦm coƧ 2 phâƦn: Lessons vaƦ  Windows Font , bạn download Phần Lessons 

tại (29,10 MB): http://goo.gl/tH40d 
 
1.LÝ DO TẠO FILE XÁC LẬP ĐỂ LƢU LẠI GIÁ TRỊ TRƢỚC ĐÓ. 

 
 File XaƧc Lâƥ p cuƤ a Chƣơng Tri Ʀnh (Preferences File) lƣu giƣ̃ các xác lập của các Bảng, Lêƥ nh vaƦ 

các Xác Lập Cân Chỉnh màn hình. Môĩ lâƦn thoaƧt khoƤ i Photoshop  viƥ  tri Ƨ cuƤ a caƧc BaƤ ng  và các Xác 
Lâƥ p cuƤ a Lêƥ nh se ̃đƣơƥ c lƣu laƥ i trong File naƦy . Khi baƥ n sƣƤ  duƥ ng chƣơng tri Ʀnh Adobe Color  
Management Assistant, các thông sôƧ  cân chiƤ nh maƦn hi Ʀnh vaƦ thông tin vêƦ không gian maƦu 

(Color Sapce) cũng sẽ đƣợc lƣu giữ trong File này. TâƧt caƤ  nhƣ̃ng gi Ʀ baƥ n lƣƥ a choƥ n trong hôƥ p 
thoại Preferences  cũng sẽ đƣợc lƣu lại trong File xác lập.  

 Trƣớc khi bắt đầu thực hành  theo các bài tập trong quyển sách này , bạn nên lƣu laƥ i File xaƧc 
lập này để có thể dùng lại nó khi cần. 

 Bạn phải trả lại các giá trị xác lập mặc định  cho PS trƣơƧc khi tiêƧ n haƦnh thƣƥ c tâƥ p môĩ 
chƣơng. ĐiêƦu naƦy baƤ o đaƤ m cho caƧc công cuƥ , bảng . . . giôƧng nhƣ mô taƤ  trong saƧch naƦy. 

 
2.CÁCH TAƥ O FILE XAƧC LÂƥ P HIÊƥ N HAƦNH CUƤ A PHOTOSHOP 

 
Chọn Menu Edit > Color Settings > Trong HaƦng Settings:  
 

1. Nếu thấy Custom đang đƣơƥ c choƥ n, bạn nhâƧp Save > Nhâƥ p tên mô taƤ  trong File Name > 
NhâƧp Save. 

http://goo.gl/tH40d
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 HT Color Settings Comment hiêƥ n ra , nhâƥ p ngaƦy , tháng và các xác lập cần lƣu ý > 

NhâƧp Ok > NhâƧp Ok. 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 

2. Nếu thấy đó là tùy chọn khác không phải là Custom > NhâƧp Ok đêƤ  đóng Hôƥ p Thoaƥ i. 

3. Trả lại các xác lập đã lƣu : Menu Edit > Color Settings > Chọn lại xác lập màu đã  lƣu NhâƧp  
Ok. 

 

3.XÁC LẬP MẶC ĐỊNH MỖI KHI THỰC HÀNH MỘT CHƢƠNG MỚI 
 

NhâƧn giƣ̃ Phi Ƨm Shift + Alt + Ctrl  ngay khi vƣƦ a khơƤ i đôƥ ng PS  đến khi hirện ra thông báo > 
NhâƧp Yes đêƤ  xoƧa caƧc xaƧc lâƥ p hiêƥ n haƦnh, trơƤ  laƥ i xaƧc lâƥ p măƥ c điƥ nh của chƣơng trình. 
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4.KHƠƤ I ĐÔƥ NG PHOTOSHOP VAƦ  MƠƤ  FILE 
 

1. KhơƤ i đôƥ ng: NhâƧP Shortcut cuƤ a Photoshop taƥ i Desktop đêƤ  mơƤ  chƣơng tri Ʀnh vaƦ lâƥ p tƣƧc giƣ̃ caƧc 
Phím Ctrl+Alt+Shift để trả lại các xác lập mặc định > Click YES ở Bảng Thông BaƧo. 

2. MơƤ  File : Chọn Menu File > Open > ĐêƧn Folder Lessons \Lessons01\Project1 > Chọn File 

01End1.psd > File 01End1.psd đƣơƥ c mơƤ  trong CƣƤ a SôƤ  AƤ nh (Image Windows). ( Các File có tên 
là End dùng để chỉ các File ảnh Kết Quả trong các bài thƣƥ c haƦnh ơƤ  môĩ chƣơng). 

 

 
 

 
  
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 

3. ĐoƧng File: Menu File > Close hoăƥ c NuƧt Close trên Thanh Tiêu ĐêƦ cuƤ a CƣƤ a sôƤ  aƤ nh naƦy . Chú ý, 

không Click vaƦo nuƧt Close cuƤ a cƣƤ a sôƤ  chƣơng tri Ʀnh PS. 
 

5.MƠƤ  FILE AƤ NH BĂƦNG FILE BROWSER 
 

1. Nhấp Nút Browser > MơƤ  ra CƣƤ a sôƤ  Mini Bridge , nhâƧp nuƧt Br  > NhâƧp Computer cƣƤ a sôƤ  TraƧi > 

ĐêƧn Project1 > Hiêƥ n ra 2 file aƤ nh 
 
 

 
  

 
 
 

 
 

 
 
 

 
 
 

 
2. MơƤ  File 01Start1.psd  băƦng môƥ t trong 2 cách sau: NhâƧp đuƧp lên hoăƥ c File> Open (Ctrl+O). 

3. ĐoƧng cƣƤ a sôƤ  File Browser: NhâƧp nuƧt Close cuƤ a cƣƤ a sôƤ  File Browser hoăƥ c File > Close 



4 

 

6.CÁC CÔNG CỤ TRONG THANH TOOLBOX 

  

Rectangular Marquee Tool (phím tắt: M): Đây là công cụ lựa chọn dạng cơ bản, lựa chọn 
vùng theo dạng hình khối cơ bản (có thể là hình chữ nhật, elip, 1 dòng đơn hoặc 1 cột đơn. 
Nếu muốn lựa chọn theo dạng hình vuông hoặc hình tròn cân đối thì giữ Shift trong quá 
trình khoanh vùng. Nếu muốn thay đổi khung chọn giữa hình chữ nhật và hình ellip thì nhấn 
Shift + M (hoặc chuột phải vào biểu tượng công cụ trên thanh Toolbox và chọn hình như ý). 

  

Move Tool (phím tắt: V): Đây là công cụ di chuyển. Nếu bạn đang chọn một vùng, sử dụng 

công cụ này để di chuyển vùng chọn đó. Bạn cũng có thể di chuyển nhiều layer một lúc sau 
khi đã chọn layer cần di chuyển. 

  

Lasso Tool (phím tắt: L): Đây là một công cụ lựa chọn khác, công cụ này cho phép bạn vẽ 
nhanh một vùng chọn. Vùng chọn này có thể là một hình dạng đặc biệt tùy theo từng phần 
trên bức ảnh của bạn. Giữ Shift + L để thay đổi chế độ chọn khoanh vùng (Lasso) hay đa 
giác (Polygonal hoặc Magnetic). 

  

Quick Selection Tool (phím tắt: W): Đây là công cụ chọn vùng gần đúng. Kích biểu tượng 

bút vẽ vào một vùng của bức ảnh, Photoshop sẽ đọc và cố gắng lấy vùng chọn có màu sắc 
tương đồng. Nhấn Shift + W để thay đổi giữa công cụ Quick Selection Tool và Magic Wand 
Tool. 

  

Crop Tool (phím tắt: C): Vẽ thành một vùng chọn hình chữ nhật, sau đó cắt lấy bức ảnh 
nằm trong vùng chọn đã vẽ. Công cụ này rất hữu ích thường được sử dụng để cắt xén một 
bức ảnh có không gian hơi "thừa". Nhấn Shift + C để thay đổi giữa công cụ Slice và Slice 
Select, một công cụ hữu ích để tạo ra nhiều hình ảnh từ một hình duy nhất, thường sử dụng 
trong việc lên hình ảnh cho một website. 

  

Eyedropper Tool (phím tắt: I): Chọn một màu bất kỳ từ tài liệu mà bạn đã mở. Shift + I để 

thay đổi giữa các công cụ: Color Sampler, Ruler và Note Tool. 

  

Spot Healing Brush Tool (phím tắt: J): Rất hữu ích trong việc xóa các vết ố, trầy xước 
không mong muốn trên ảnh. Nhấn Shift + J để thay đổi giữa Healing Brush, Patch Tool và 
công cụ Red Eye (dùng để xử lý mắt đỏ) 

  

Brush Tool (phím tắt: B): Đây là công cụ phứt tạp duy nhất trên Toolbox. Rất nhiều bài trên 

Quản Trị Mạng đã hướng dẫn sử dụng công cụ này để vẽ các hình ảnh lặp đi lặp lại. Nhấn 
Shift + B để lựa chọn lần lượt công cụ Pencil, Color Replacement Tool, và Mixer Brushes. 

  

Clone Stamp Tool (phím tắt: S): Đây cũng là một công cụ brush sửa ảnh khác, giữ Alt và 
kích chuột vào vùng nền "nguồn" và sau đó kích chuột trái chọn vùng nền muốn "phủ" vùng 
"nguồn" lên. Nhấn Shift + S để chọn các công cụ đóng dấu khác nhau. 

  

History Brush Tool (phím tắt: Y): Làm việc song song với History Palette, bạn có thể "lấy lại 

màu gốc" với công cụ này. Sử dụng như một công cụ lọc, bạn chọn phần muốn lấy lại màu 
nền như ảnh gốc (phần được chọn phải nằm trong vùng đã bị thay đổi nền). Nhấn Shift + Y 
để thay đổi giữa History Brush Tool và Art History Brush Tool. 

  

Eraser Tool (phím tắt: E): Đây là công cụ dùng để xóa một vùng ảnh. Nếu ảnh là layer 

Background hoặc bị khóa thì vùng bị xóa sẽ lấy theo màu Background Color. Nhấn Shift + E 
để chuyển giữa chế độ xóa Eraser, Background Eraser, hay Magic Eraser. 

  

Gradient Tool (phím tắt: G): Kích và kéo gradient màu phủ đầy lên layer hoặc vùng mà bạn 

chọn bằng màu foreground và background trên thanh công cụ. Có rất nhiều tùy chọn 
gradient màu bạn có thể sử dụng. Mở rộng trong công cụ này còn có Paint Bucket Tool - 
dùng để phủ một màu đơn cho 1 vùng hoặc 1 layer đang chọn. Nhấn Shift + G để chuyển 
đổi giữa 2 chế độ phủ màu. 

  

Blur, Sharpen, and Smudge Tools: mặc định, công cụ này không có phím tắt. Có ba công 

cụ chỉnh sửa ảnh nằm trong nút công cụ này. Smudge là thanh công cụ đặc biệt có thể tạo 
hiệu ứng vuốt màu tuyệt vời trên hình ảnh của bạn. Chuột phải vào nút công cụ để chọn 
những công cụ khác nhau: Blur và Sharpen. 

  

Dodge and Burn Tools (phím tắt: O): Dodge và Burn là công cụ chỉnh sửa giúp làm sáng 
hoặc tối một vùng cho bức ảnh. Nhấn Shift + O để thay đổi lựa chọn giữa các công cụ. 
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Pen Tool (phím tắt: P): Đây là một công cụ "gây ác mộng" cho người dùng mới bắt đầu. 
Các công cụ Pen rất khó trong việc sử dụng nhưng là một ưu điểm của Photoshop. Shift + P 
sẽ cho phép bạn chuyển đổi giữa các công cụ làm việc với path (đường dẫn). 

  

Type Tool (phím tắt: T): Cho phép bạn nhập một đoạn nội dung, mặc định là theo chiều 

ngang. Nhấn Shift + T để chọn công cụ Vertical Type Tool (nhập nội dung theo chiều dọc) 
và Type Mask Tools. 

  

Path Selection and Direct Selection Tools (phím tắt: A): Đây là một công cụ chỉnh sửa 
các phân đoạn trong một đoạn đường dẫn (path). Có thể bỏ qua công cụ này trừ khi bạn sử 
dụng Pen Tool để vẽ 1 đoạn đường dẫn. Nhấn Shift + A để chuyển đổi giữa Path Selection 
và Direct Selection. 

  

Custom Shape Tool (phím tắt: U): Đây là công cụ để tạo các hình vector hoặc clipart từ một 

thư viện hình có sẵn. Nhấn Shift + U để lựa chọn giữa các công cụ vẽ hình chữ nhật, tam 
giác, các đường nét và hình clipart. 

  

Zoom Tool (phím tắt: Z): Đây là công cụ dùng để zoom to và nhỏ ảnh. Phóng to với việc 

nhấn chuột trái và thu nhỏ bằng cách nhấn thêm Alt trong khi kích chuột. Đây là công cụ cơ 
bản nhất trên thanh công cụ. 

  

Hand Tool (phím tắt: H): Cuộn tài liệu mà không cần sử dụng con trỏ chuột hay phím mũi 
tên. Nhấn và giữ phím Space bất cứ khi nào bạn cần sử dụng công cụ này, nhả phím Space 
khi không cần sử dụng đến nó nữa. 

  

Background/Foreground: Đây là bảng 2 màu sắc đang được sử dụng để chỉnh sửa ảnh. 
Màu trên là Foreground, màu dưới là Background. Nhấn phím X trên bàn phím để chuyển 
đổi màu Foreground thành Background và ngược lại. Nhấn phím D để đưa 2 màu này về 
mặc định là trắng và đen. 

  

Quick Mask Mode (phím tắt: Q): Đây là một chế độ thay thế cho việc tạo các lựa chọn phức 

tạp với các công cụ Brush, Eraser và Paint Bucket. Nhấn phím Q để chuyển đổi giữa việc 
chọn chế độ Quick Mask Mode và chế độ thường. 

 

Theo Quantrimang 
 
7.SƢƤ  DUƥ NG CÔNG CUƥ  ZOOM 
 

 
 

1. Bạn thấy Cấp độ thu phóng ảnh thể hiện trên Thanh Tiêu Đề . Đặt con trỏ (Không nhâƧp lê n) 

Công Cuƥ  Zoom, hiêƥ n ra môƥ t văn baƤ n nhoƤ  ( Tooltip) cho biêƧt tên công cuƥ  vaƦ Phi Ƨm TăƧt. 
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2. Phóng to (Zoom in): Chọn công cụ Zoom : NhâƧp vaƦo công cuƥ  naƦy hoăƥ c Phi Ƨm Z > Đặt công 
cụ vào ảnh bạn thấy biểu tƣợng kính lúo có  dâƧu + > NhâƧp lên bâƧt cƣƧ viƥ  tri Ƨ naƦo trong aƤ nh , nơi 

đoƧ đƣơƥ c phoƧng đaƥ i câƧp đôƥ  môĩ lâƦn thêm 100% trên Thanh Tiêu ĐêƦ , vị trí Click sẽ trở thành 
tâm aƤ nh, trong PS CS5 câƧp đôƥ  tôƧi đa laƦ 3200%. 

3. Thu nhoƤ  (Zoom Out): Giƣ̃ Phi Ƨm Alt, biêƤ u tƣơƥ ng Zoom coƧ dâƧu - > NhâƧp lên aƤ nh , ảnh sẽ thu 

nhỏ theo cấp độ giảm từng 100% còn tối thiểu là1,5% trong PS CS5.  
4. Bạn có thể chọn Zoom In và Zoom Out  trên Thanh TuƦy Choƥ n (Options Bar) hoăƥ c vaƦo 

Menu View > Chọn Zoom In (Ctrl++) và Zoom Out (Ctrl--) hoăƥ c nhâƥ p trƣƥ c tiêƧp trong Zoom 

Levels ơƤ  đaƧy TraƧi maƦn hi Ʀnh > NhâƧp Enter. 
5. Drag taƥ o vuƦng choƥ n trên môƥ t viƥ  tri Ƨ aƤ nh câƦn phoƧng to > Buông con troƤ  aƤ nh đa ̃phoƧng to. 

 

 
8.CHỌN VÀ SỬ DỤNG CÔNG CỤ ẨN 

 
Photoshop CS5 có râƧt nhiêƦu công cuƥ  duƦng đêƤ  chiƤ nh sƣƤ a File aƤ nh . Hôƥ p Công cuƥ  (TollBox) săƧp xêƧp caƧc 
công cuƥ  theo NhoƧm , môĩ NhoƧm chiƤ  thêƤ  hiêƥ n môƥ t công cuƥ ,các công cụ khác của Nhóm nằm ẩn dƣới 

công cuƥ  naƦy. 
Khi baƥ n thâƧy môƥ t công cuƥ  coƧ môƥ t hình tam giác nhỏ xuất hiện góc dƣới bên Phải của nút công cụ , 
thông baƧo cho baƥ n biêƧt laƦ coƦn môƥ t sôƧ công cuƥ  khaƧc âƤ n dƣơƧi noƧ . 

 
 

 
 
 

 
 

 
 
 

 
1. Đặt con trỏ tại nút công cụ , xuâƧt hiêƥ n nhañ văn baƤ n thông baƧo đoƧ laƦ công cuƥ  Rectang ular 

Marquee vaƦ phi Ƨm tăƧt laƦ M. 
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2. ĐêƤ  choƥ n công cuƥ  Elliptical Marquee âƤ n dƣơƧi công cuƥ  Rectangular Marquee , bạn sử dụng một 
trong caƧc caƧch: 

 
 NhâƧp giƣ̃ con troƤ i lên công cuƥ  RM, xuâƧt hiêƥ n caƧc công cuƥ  âƤ n > Chọn EM. 

 NhâƧp Alt+Click tƣƦ ng châƥ p laƦm xuâƧt hiêƥ n tƣƦ ng công cuƥ  âƤ n vaƦ choƥ n noƧ . 
 Giƣ̃ Phi Ƨm Shift vaƦ nhâƧp Phi Ƨm tăƧt M tƣƦ ng châƥ p đêƤ  xuâƧt hiêƥ n caƧc công cuƥ  âƤ n vaƦ choƥ n noƧ . 

 Khi công cuƥ  Elliptical Marquee đang đƣơƥ c choƥ n ,bạn đặt con trỏ vào trong Cửa Sổ  Ảnh, 

con troƤ  thaƦnh HIƦnh Chƣ̃ Thâƥ p + (Crosshairs). 
 Drag (GiƣƤ  vaƦ rê con troƤ ) tạo vùng chọn trên ảnh > Thả chuột bạn đã tạo thành một 

vùng chọn. Bạn có thể chỉnh sửa trong vùng chọn này mà không làm ảnh hƣởng đến 
các vùng ngoài vùng chọn. 

 

 
 

 
 

 

 
 
 

 
 

 
 
 

 
 

 
 
 

 ĐêƤ  con troƤ  trong vuƦng choƥ n , nó trở thành hình Mủi tên có hình chữ nhật nhỏ thông 
báo rằng bạn có thể di chuyển vùng chọn > Bạn rê vùng chọn qua cô bé bên Phải . Khi 

bạn di chuyển vùng chọn, các pixels ảnh của vùng chọn cũ  sẽ không bị thay đổi vị trí , 
chỉ có biên chọn thay đổi vị trí và một vùng ãnh mới đƣợc chọn . NêƧu muôƧn di chuyêƤ n 

các pixels ảnh trong vùng ảnh cũ  bạn phải dùng một kỹ thuật khác. (Sẽ học sau). 
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9.ÁP DỤNG VÙNG CHỌN 
 

1. Bạn tạo vùng chọn khuôn mặt nhân vật , để bảo vệ vùng chọn này không bị thay đổi bạn hãy 
chọn vùng ngoài vùng chọn này bằng cách nhấp Menu Select | Inverse (Shift+Ctrl+I). 

2. Curves: Menu Image | Adjustements | Curves (Ctrl+M) > ĐaƧnh dâƧu choƥ n Preview trong 

Curves, bạn rê theo Hình để làm sậm màu Vùng chọn bên ngoài nhân vật hoặc nhập giá trị 
vào OutPut và InPut > NhâƧp Ok. 

3. Lƣu: Menu File | Save As > Ra BaƤ ng Save As, chọn Desktop làm nơi lƣu – File name đăƥ t tên – 

Chọn định dạng (ThƣơƦng laƦ PSD , JPEG hoăƥ c PNG) > NhâƧp NuƧt Save > Close PS. 
 

 

  
10.CÔNG CUƥ  ZOOM 
 

Khi baƥ n nhâƧp công cuƥ  Zoom se ̃xuâƧt hiêƥ n Thanh TuƦy Choƥ n cuƤ a công cuƥ  naƦy dƣơƧi Thanh Menu.  
 

1. BiêƤ u tƣơƥ ng Zoom : Đầu tiên là biểu tƣợng Zoom , bạn nhấp lên nút xổ xuống , hiêƥ n ra caƧc 
công cuƥ  vƣƦ a sƣƤ  duƥ ng , chọn một công cụ và nhấp nút tam giác bên Phải > Hiêƥ n ra Menu con 
để bạn tùy chọn  > NhâƧp nuƧt Vuông bên Ph ải để chọn lƣu công cụ có kích cở đã do bạn ấn 

điƥ nh. 
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2. BiêƤ u tƣơƥ ng Zoom: Đầu tiên là biểu tƣợng Zoom , bạn nhâƧp PhaƤ i lên nuƧt xôƤ  xuôƧng , hiêƥ n ra 
Reset Tool (Trả lại mặc định cho công cụ Zoom) – Reset All Tool ( Trả lại mặc định cho tất 

cả các công cụ). 
 

 

3. Nút Zoom In (Kính Lúp dấu +): Chọn công cụ này > NhâƧp lên aƤ nh > Ảnh se ̃đƣơƥ c phoƧng 
lơƧn môĩ lâƦn câƧp đôƥ  tăng 100% hoăƥ c Rê lên aƤ nh đêƤ  phoƧng to vuƦng vƣƦ a rê , vùng này sẽ nằm 

ngay tâm CƣƤ a SôƤ  AƤ nh. NhâƧp Phi Ƨm Alt biêƤ u tƣơƥ ng ki Ƨnh luƧp se ̃coƧ dâƧu – dùng để thu nhỏ ảnh. 
 

4. Nút Zoom In (Kính Lúp dấu -): Chọn công cụ này > NhâƧp lên aƤ nh > Ảnh se ̃đƣơƥ c thu nhoƤ  

môĩ lâƦn câƧp đôƥ  giảm 100% NhâƧp Phi Ƨm Alt biêƤ u tƣơƥ ng ki Ƨnh luƧ p se ̃coƧ dâƧu + dùng để phóng to 
ảnh. 

 

 
 

5. Resize Windows To Fit: Khi choƥ n tuƦy choƥ n naƦy , bạn bạn nhấp hoặc rê để thu nhỏ hay 
phóng to ảnh, kích thƣớc Cửa Sổ Ảnh sẽ tự động thay đổi theo. 
 

6. Ignore Palettes: Tùy chọn này chỉ có hiêƥ u lƣƥ c khi tuƦy choƥ n Resize Windows To Fit đƣơƥ c 
chọn, khi bâƥ n phoƧng lơƧn aƤ nh ki Ƨch thƣơƧc cƣƤ a sôƤ  aƤ nh se ̃tăng theo vaƦ cho pheƧp lâƧn vaƦo phâƦn 
dƣơƧi cuƤ a caƧc BaƤ ng (Palettes). 

 
7. Zoom Al Windows: Khi baƥ n thu phoƧng aƤ nh trong kôƥ t CƣƤ a SôƤ  AƤ nh, thì tất cả các Cửa Sổ Ảnh 

đang duco975 mơƤ  (NêƧu coƧ)  sẽ thay đổi cấp độ thu phóng tỉ lệ tỉ lệ theo . Bạn giữ Shift trong 
lúc thu phóng cũng cho kết quả tƣơng tự. 
Chú Ý: Các tùy chọn Windows To Fit - Ignore Palettes - Zoom Al Windows không coƧ taƧc duƥ ng 

khi baƥ n thay đôƤ i câƧp đôƥ  thu phoƧng ơƤ  hôƥ p nhâƥ p trên Thanh Traƥ ng ThaƧi (Góc đáy Trái)  hoăƥ c sƣƤ  
dụng Bảng navigator. 

 
8. Actual Pixels: Kích thƣớc Một Pixel của Ảnh bằng Một Pixel của màn hình .Tỷ lệ Độ phân giaƤ i 

(Resolution) của ảnh và màn hình là 100%. 

 
9. Fit On Screen: Ảnh vừa khít với Cửa Sổ. 

 

10. Print Size: ThêƤ  hiêƥ n aƤ nh gâƦn đuƧng vơƧi ki Ƨch thƣơƧc đƣơƥ c in ra. 
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11.MÔƥ T SÔƧ  PHIƧM TĂƧT THU PHOƧNG AƤ NH 
 
 

PHÍM TẮT CÔNG DUƥ NG 

CTRL+ ZOOM IN , Không thay đôƤ i ki Ƨch thƣơƧc cƣƤ a sôƤ  

CTRL- ZOOM OUT , Không thay đôƤ i ki Ƨch thƣơƧc cƣƤ a sôƤ  

CTRL ALT + ZOOM IN , Thay đôƤ i ki Ƨch thƣơƧc cƣƤ a sôƤ . 

CTRL ALT - ZOOM OUT , Thay đôƤ i ki Ƨch thƣơƧc cƣƤ a sôƤ . 

CTRL ALT 0 ACTUAL PIXELS hoăƥ c 100% 

CTRL 0 FIT ON SCREEN 

 

 
 
12.MÔƥ T SÔƧ  PHIƧM TĂƧT TẠM THỜI CHUYỂN SANG CÔNG CỤ ZOOM 

 
 Trong khi môƥ t công cuƥ  khaƧc đang đƣơƥ c choƥ n , bạn nhấp Ctrl+SpaceBar để chuiyển sang 

Zoom In  hoăƥ c nhâƧp Alt+SpaceBar chuyêƤ n sang Zoom Out.  
 Rê trên aƤ nh đêƤ  thay đôƤ i câƧp đôƥ  thu phoƧng aƤ nh. Thả các phím trở lại công cụ trƣớc đó. 

 NhâƧp đuƧp công cuƥ  Zoom đêƤ  chuyêƤ n aƤ nh vêƦ câƧp đôƥ  thu phoƧng 100%. 
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13.SƢƤ  DUƥ NG CAƧC PHIƧM KÊƧT HƠƥ P TRONG KHI DUƦNG ZOOM 
 

1. Bỏ vùng chọn: Bạn chọn công cụ Elliptical Marquee vaƦ taƥ o vuƦng choƥ n trên aƤ nh . Bạn có nhiều 
cách bỏ chọn công cụ này : Trong CƣƤ a SôƤ  AƤ nh , nhâƧp bên ngoaƦi vuƦng choƥ n hoăƥ c choƥ n Menu 
Select | Deselect hoăƥ c Ctrl+D. 

2. Cách tạo vùng chọn dùng thêm 2 Phím: Đặt con trỏ ngay tâm nhân vậ t đôƦng thơƦ i giƣ̃ 
phím Alt+Shift, rê ra ngoaƦi khuôn măƥ t > Thả chuột ra , bạn đã tạo vùng chọn hình tròn . 
NêƧu baƥ n vô ti Ʀnh thaƤ  môƥ t trong 2 phím, công cuƥ  Elliptical se ̃taƥ o ra vuƦng choƥ n tròn chéo, nêƧu 

chƣa thaƤ  chuôƥ t baƥ n nhâƧn laƥ i 2 phím và rê lại. 
3. Di chuyêƤ n vuƦng choƥ n: Đặt con trỏ vào trong vùng chọn > Con troƤ  hiêƥ n ra biêƤ u tƣơƥ ng mơƧi , 

rê vuƦng choƥ n qua viƥ  tri Ƨ mơƧi. 
4. Zoom: NhâƧp đuƧp vaƦo công cuƥ  Zoom đêƤ  chuyêƤ n câƧp đôƥ  thu phoƧng aƤ nh vêƦ 100%. Vùng chọn 

vâñ tôƦn taƥ i sau khi baƥ n duƦng công cuƥ  Zoom  > NêƧu toaƦn bôƥ  aƤ nh traƦn maƦn hi Ʀnh , bạn sử dụng 

các nút tùy chọn của công cụ này nhƣ sau: 
 Actual Pixels: Hiêƥ n aƤ nh đuƧng câƧp đôƥ  100%. 

 Fit Screen: VƣƦ a khi Ƨt maƦn hi Ʀnh. 
 Fill Screen: LâƧp đâƦy maƦn hình. (To hơn Fit Screen môƥ t chuƧt). 

 Print Size: Ảnh hiện ra giống khi in. 

 
  

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

14.CÔNG CUƥ  HAND 
 

 
 

1. Trong trƣơƦng hơƥ p CuƤ a SôƤ  AƤ nh không thêƤ  hiêƥ n hêƧt toaƦn bôƥ  aƤ nh ,bạn dùng Công Cụ HAND  rê 
để di chuyển hoặc cuộn (Scroll) tơƧi vuƦng aƤ nh muôƧn xem trong CƣƤ a SôƤ  AƤ nh .NêƧu toaƦn bôƥ  aƤ nh 

đa ̃thêƤ  hiêƥ n đâƦy đuƤ  trong CSA thi Ʀ HAND se ̃không taƧc duƥ ng. 
2. Khi choƥ n HAND thi Ʀ Thanh TuƦy Choƥ n cũng xuâƧt hiêƥ n , tùy chọn: Actual Pixels – Fit On Screen  

và Print Size  có chức năng giống TTC của Zoom. 
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3. Tùy chọn Scroll  Al Windows  nêƧu baƥ n rê cuôƥ n aƤ nh thi Ʀ tâƧt caƤ  các ảnh trong CSA  đang 
đƣơƥ c mơƤ   se ̃thay đôƤ i tƣơng ƣƧng theo.(Hoăƥ c vƣƦ a Rê vƣƦ a giƣ̃ Shift). 

 
4. NhâƧp đuƧp lên HAND se ̃thêƤ  hiêƥ n toaƦn bôƥ  aƤ nh lơƧn nhâƧt giôƧng tuƦy choƥ n Fit On Scree. 

 

 
5. Trong khi đang choƥ n công cuƥ  khaƧc , bạn giữ Phím SaopceBar để hiện ra công cụ HAND , thả 

Space Bar trơƤ  laƥ i công cuƥ  hiêƥ n haƦnh. 

 
 

15.MÔƥ T SÔƧ  PHIƧM TĂƧT 
 
 

PHÍM TẮT CÔNG DUƥ NG 

PAGE UP Cuôƥ n lên môƥ t màn hình 

SHIFT+PAGE UP Cuôƥ n lên 10 Pixels 

PAGE DOWN Cuôƥ n xuôƧng môƥ t maƦn hi Ʀnh 

SHIFT+PAGE DOWN Cuôƥ n xuôƧng 10 Pixels 

CTRL+PAGE UP Cuôƥ n sang TraƧi môƥ t maƦn hi Ʀnh 

CTRL+SHIFT+PAGE UP Cuôƥ n sang TraƧi 10 Pixels 

CTRL+PAGE DOWN Cuôƥ n sang PhaƤ i môƥ t maƦn hi Ʀnh 

CTRL+SHIFT+PAGE DOWN Cuôƥ n sang PhaƤ i 10 Pixels 

HOME Di chuyêƤ n tơƧi goƧc trên, bên TraƧi aƤ nh. 

END Di chuyêƤ n tơƧi goƧc dƣơƧi, bên PhaƤ i aƤ nh. 

 
 

 
16.BẢNG NAVIGATOR 
 

1. Bảng Navigator cho phép bạn thu phóng (Zoom) hoăƥ c cuôƥ n aƤ nh (Scroll) tùy theo tửng trƣờng 
hơƥ p. Bảng này nằm trong Nhóm Bảng Navigator -Info-Histogram. Bạn mở Bàng : Menu 
Windows | Navigator. 

2. MơƤ  môƥ t File aƤ nh > MơƤ  BaƤ ng Navigator : Menu Windows | Navigator > Rê con trƣơƥ t đêƤ  tăng 
giảm độ thu phóng ảnh .Khung maƦu đoƤ  đaƥ i diêƥ n cho phâƦn aƤ nh đang thêƤ  hiêƥ n trong CSA . NêƧu 

bạn rê con trƣợt còn 50%, bạn thấy ảnh trong Navigator bao viền đỏ và thấy ảnh trong CSA 
còn 50%. 

3. Bạn có thể nhập trực tiếp giá trị % (100%, 250%) hoăƥ c nhâƥ p tiƤ  lêƥ  (1:1, 4:1) trong hôƥ p nhâƥ p 

Zoom Percentage > NhâƧp Phi Ƨm Enter . CpâƧ đôƥ  thu phoƧng nhoƤ  nhâƧt laƦ 0,44% và lớn nhất là 
3200%. 

4. ĐêƤ  nhanh choƧng nhâƥ p giaƧ triƥ , bạn nhấp đúp vào hộp nhập này , nhâƥ p giaƧ triƥ  vaƦ nhâƧp 
Shift+Enter thay vi Ʀ Enter. 

5. NhâƧp NuƧt Zoom Out hoăƥ c Zoom In đêƤ  thu phoƧng theo câƧp đôƥ  điƥ nh săñ. 

6. Cuôƥ n aƤ nh: Đặt con trỏ vào Khung Màu Đỏ , con troƤ  biêƧn thaƦnh baƦn tay , rê đêƤ  thay đôƤ i phâƦn 
ảnh thể hiện trong CSA. 
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1. Chọn công cụ Hand, giƣ̃ Phím Ctrl, đ63ể con trỏ vào Khung Viền Đỏ , con troƤ  biêƧn thaƦnh Ki Ƨnh 
Lúp, rê taƥ o vuƦng choƥ n coƧ viêƦn đoƤ  > Lâƥ p tƣƧc aƤ nh trong CSA thêƤ  hiêƥ n vuƦng vƣƦ a choƥ n.  
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2. Đổi Màu cho Khung View Box: NhâƧp nuƧt xôƤ  xuôƧng > NhâƧp Panel Options > NHâƧp NuƧt maƦu đêƤ  
chọn màu khác. 

 
 
 

 
 
 

 
 

 
  

 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

17.SƢƤ  DUƥ NG THANH TUƦY CHOƥ N (OPTIONS BAR) 
 
Bạn download Phần Lessons tại (29,10 MB): http://goo.gl/tH40d và lƣu tại Desktop. 

 
1. Khi baƥ n choƥ n môƥ t công cuƥ ,thanh tuƦy choƥ n tƣơng ƣƧng xuâƧt hiêƥ n . Trong Phiên baƤ n Photoshop 

CS5 còn xuất hiện nhiều tùy chọn trên Thanh Menu, gôƦm coƧ: 

 
2. NhâƧp nuƧt Launch Bridge > CƣƤ a sôƤ  cuƤ a nuƧt naƦy bâƥ t ra , ĐêƧn Folder Projects2 > Khung Content 

mơƤ  ra coƧ 2 Files hiêƥ n ra > NhâƧp File 01Start2 > Khung Preview hiêƥ n ra  cuƦng caƧc dƣ̃ liêƥ u liên 
quan đêƧn aƤ nh naƦy . Bạn có thể di chuyển Vạch Đứng để nới rộng hay thu hẹp 3 Khung naƦy 

băƦng caƧch đêƤ  con troƤ  taƥ i Vaƥ ch Đúng, hiêƥ n ra MuƤ i tên 2 đâƦu vaƦ rê. NhâƧp đuƧp lên File naƦy. 
 

http://goo.gl/tH40d
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3. Công Cuƥ  Văn BaƤ n : Ảnh này đã đƣợc mở trong CSA , bạn chọn công cụ văn bản và nhập 
dòng ghi chú mới > Thanh tuƦy choƥ n hiêƥ n ra vơƧi caƧc TuƦy Choƥ n liên quan đêƧn công cuƥ  vƣƦ a 

chọn, bạn chọn: 
 
 Trong Unikey, chọn Bảng mả Unicode – KiêƤ u goƤ  VNI. 

 Chọn Font: Arial. 

 Chọn kiểu chữ: Bold Italic. 
 Kích cỡ chữ: 12 pt. 

 Trạng thái: Sharp tô nôƤ i. 

 Vị trí: Sát lề Trái 
 Màu : Xanh laƧ cây. 

 NhâƧp con troƤ  taƥ i đâƦu doƦng và gỏ: utbinhdesign chaƦo caƧc baƥ n. 
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4. NhâƧp Công Cuƥ  MOVE > Trong Tab Layers choƥ n Layer chƣƧa văn baƤ n , rê văn baƤ n naƦy xuôƧng 

Khung đaƧy PhaƤ i. 
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CÁC BÀI VIẾT VÀ SƢU TẦM CỦA ÚT BỈNH 
 

PHOTOSHOP CS5 EXTENDED 
ÚT BỈNH UPLOAD 6.5.2011 
 
DOWNLOAD CHƢƠNG TRIƦNH PS CS5: http://goo.gl/SBcG2 
HƢƠƧNG DẪN DOWNLOAD VAƦ  CAƦI ĐĂƥ T PS CS 5: 

http://goo.gl/zzY1T 
LINKS DOWNLOAD PHOTOSHOP CS5 ÚT BỈNH UPLOAD 
PHOTOSHOPCS5EXTENDED.part01: 

http://www.mediafire.com/?f3hxpdve1ski8eq 
PHOTOSHOPCS5EXTENDED.part02: 

http://www.mediafire.com/?bdngde9wn92lijo 
PHOTOSHOPCS5EXTENDED.part03: 
http://www.mediafire.com/?2qt3kfpxvp7ewln 

PHOTOSHOPCS5EXTENDED.part04: 
http://www.mediafire.com/?2qtpv6b1t1f611b 

PHOTOSHOPCS5EXTENDED.part05: 
http://www.mediafire.com/?9vcppop8xm1yvsk 
PHOTOSHOPCS5EXTENDED.part06: 

http://www.mediafire.com/?wrgu3xadper1vod 
PHOTOSHOPCS5EXTENDED.part07: 

http://www.mediafire.com/?d4c4e8dhe78drur 
LINKS DOWNLOAD PS CS5 ÚT BỈNH UPLOAD 6.5.2011: 
http://goo.gl/gBxed 

PHOTOSHOP CS5, 26 BÀI HƢỚNG DẪN SỬ DỤNG: 
http://goo.gl/fb5VP 
PHOTOSHOP CS5 ÚT BỈNH SƢU TẦM: 

http://goo.gl/HQxXT 
PHOTOSHOP CS5 LINKS DOWNLOAD 12 PART MEDIAFIRE: 

http://goo.gl/pXrtC 
90 Bài viết của Út Bỉnh: 
http://goo.gl/YdmsU 

PS CS5 HƣơƧng dâñ laƦm TrăƧng Răng: http://goo.gl/N8sMM 
HƣơƧng dâñ laƦm TrăƧng Răng Daƥ ng.DOC (683 KB): 

http://utbinh.com/4/07052011/lamtrangrang.doc 
HƣơƧng dâñ laƦm TrăƧng Răng Daƥ ng.PDF (549 KB): 
http://utbinh.com/4/07052011/lamtrangrang.pdf 

HƣơƧng dâñ laƦm TrăƧng Răng Daƥ ng.HTM: 
http://utbinh.com/4/07052011/lamtrangrang.htm 
Video hƣơƧng dâñ LAƦM TRĂƧNG RĂNG 

http://www.youtube.com/watch?v=0s5uFCKMRmw 
BÓNG ĐỔ 17 BÀI VIẾT CỦA ÚT BỈNH (10,59 MB): 

http://goo.gl/8m6bH 
ACTIONS 15 BÀI VIẾT CỦA ÚT BỈNH (11,94 MB): 
http://goo.gl/8Rgwl 

900 ACTIONS PHOTOSHOP (40,30 MB): 
http://goo.gl/IcoVC 

Photoshop CS5: Ảnh Thiếu Sáng Dạng DOC (1,66 MB): 
http://utbinh.com/4/11052011/anhthieusang.doc 
XEM VIDEO: http://goo.gl/tN5jW 

PHOTOSHOP CS5: ẢNH DƢ SÁNG DẠNG DOC (601 KB): 

http://goo.gl/SBcG2
http://goo.gl/zzY1T
http://www.mediafire.com/?f3hxpdve1ski8eq
http://www.mediafire.com/?bdngde9wn92lijo
http://www.mediafire.com/?2qt3kfpxvp7ewln
http://www.mediafire.com/?2qtpv6b1t1f611b
http://www.mediafire.com/?9vcppop8xm1yvsk
http://www.mediafire.com/?wrgu3xadper1vod
http://www.mediafire.com/?d4c4e8dhe78drur
http://goo.gl/gBxed
http://goo.gl/fb5VP
http://goo.gl/HQxXT
http://goo.gl/pXrtC
http://goo.gl/YdmsU
http://goo.gl/N8sMM
http://utbinh.com/4/07052011/lamtrangrang.doc
http://utbinh.com/4/07052011/lamtrangrang.pdf
http://utbinh.com/4/07052011/lamtrangrang.htm
http://www.youtube.com/watch?v=0s5uFCKMRmw
http://goo.gl/8m6bH
http://goo.gl/8Rgwl
http://goo.gl/IcoVC
http://utbinh.com/4/11052011/anhthieusang.doc
http://goo.gl/tN5jW
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http://utbinh.com/4/12052011/anhdusang.doc 
XEM VIDEO HƢƠƧNG DẪN AƤ NH DƢ SAƧNG: http://goo.gl/9KIWI 

KS DƣƠNG TRUNG HIÊƧU 30 DỈA VIDEO HƢỚNG DẪN: 
http://goo.gl/2VhSO 
30 Dỉa Video Hƣớng dẫn Photoshop của KS Hiếu dạng DOC (1,92 MB): 

http://utbinh.com/4/12052011/30DIAKSDUONGTRUNGHIEU.doc 
30 Dỉa Video Hƣớng dẫn Photoshop của KS Hiếu dạng PDF (1,67 MB): 
http://utbinh.com/4/12052011/30DIAKSDUONGTRUNGHIEU.pdf 

30 Dỉa Video Hƣớng dẫn Photoshop của KS Hiếu dạng HTM: 
http://utbinh.com/4/12052011/30DIAKSDUONGTRUNGHIEU.htm 

Tạo Dỉa Video Hƣớng dẫn thực hành Photoshop cảu KS Dƣơng Trung Hiếu: 
http://goo.gl/vQbTu 
E-Book Photoshop cs5: 

http://tinyurl.com/utbinh462 
 

PHỤC HỒI ẢNH CHUYÊN NGHIỆP 
 
23 Bài viết của Út Bỉnh 

Links 4Shared: http://goo.gl/88oln 
Links Mediafire: http://goo.gl/eLsJv 
http://www.mediafire.com/?svl4d127hbnmelt 

 
TẠO BÓNG ĐỔ TRONG PHOTOSHOP 

 
17 Bài viết của Út Bỉnh: http://goo.gl/pKNPn 
http://www.mediafire.com/?ir9qo5ocochla72 

 
TẠO ACTIONS TRONG PHOTOSHOP 

 
15 BÀI VIẾT CỦA ÚT BỈNH (11,94 MB): http://goo.gl/8Rgwl 
http://www.mediafire.com/?0r8kbbokbb8x653 

 
PHOTOSHOP CS4 

 
90 Bài viết của Út Bỉnh: 
http://goo.gl/YdmsU 

21 LESSONS PHOTOSHOP CS4 (50,19 MB): http://goo.gl/KM2Zq 
ĐOƥ C THÊM PHOTOSHOP CS4 (142,87 MB) : http://goo.gl/mABQt 
200 KHUNG HIƦNH MẪU (149,57 MB): http://goo.gl/2nx7h 

KNOCK OUT VAƦ  EXTRACT PLUS ( 141,8 KB): http://goo.gl/n5FCS 
SÁCH PHOTOSHOP CS 4 (79,98 MB): http://goo.gl/mVDPq 

SẢN PHẨM PHOTOSHOP CS4 (1,55 MB): http://goo.gl/bTCyt 
SÔƤ  TAY PHOTOSHOP PART 1 (195,31 MB): http://goo.gl/XDB3X 
SÔƤ  TAY PHOTOSHOP PART 1 (195,31 MB): http://goo.gl/qY3Nj 

SÔƤ  TAY PHOTOSHOP PART 1 (163,17 MB) : http://goo.gl/fHEXC 
HÌNH WALLPAPER XMAS (32,48 MB) : http://goo.gl/z2gvG 

 
 
ACTIONS TRONG PHOTOSHOP 

TẠO 9 ẢNH 3X4 
 
 File DOC:http://goo.gl/RG9km  

 File PDF:http://goo.gl/DOh6F 
Video: http://tinyurl.com/utbinh471 

http://goo.gl/TC5o http://goo.gl/lPae4 

http://utbinh.com/4/12052011/anhdusang.doc
http://goo.gl/9KIWI
http://goo.gl/2VhSO
http://utbinh.com/4/12052011/30DIAKSDUONGTRUNGHIEU.doc
http://utbinh.com/4/12052011/30DIAKSDUONGTRUNGHIEU.pdf
http://utbinh.com/4/12052011/30DIAKSDUONGTRUNGHIEU.htm
http://goo.gl/vQbTu
http://tinyurl.com/utbinh462
http://goo.gl/88oln
http://goo.gl/eLsJv
http://www.mediafire.com/?svl4d127hbnmelt
http://goo.gl/pKNPn
http://www.mediafire.com/?ir9qo5ocochla72
http://goo.gl/8Rgwl
http://www.mediafire.com/?0r8kbbokbb8x653
http://goo.gl/YdmsU
http://goo.gl/KM2Zq
http://goo.gl/mABQt
http://goo.gl/2nx7h
http://goo.gl/n5FCS
http://goo.gl/mVDPq
http://goo.gl/bTCyt
http://goo.gl/XDB3X
http://goo.gl/qY3Nj
http://goo.gl/fHEXC
http://goo.gl/z2gvG
http://goo.gl/RG9km
http://goo.gl/DOh6F(pdf)
http://tinyurl.com/utbinh471
http://goo.gl/TC5o
http://goo.gl/lPae4
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http://goo.gl/bbcZJ http://goo.gl/tLzpr 
http://www.youtube.com/watch?v=XaDWr5yhc98 

 Download aƤ nh “goc3x4” đêƤ  thƣƥ c tâƥ p: 
 http://goo.gl/C5dLl 
 Download aƤ nh utbinh3x4 để thực tập: 

 http://goo.gl/8nyxn 
 Tạo Dỉa Video Hƣớng dẫn thực hành Photoshop: 
 http://goo.gl/vQbTu 

 Download File Actions “tao9anh3x4.atn” taƥ i (1,76 KB): 
 http://goo.gl/ANugG 

 File aƤ nh 4x6 của bạn hoặc ảnh Brigitte Bardot tại: 
 http://goo.gl/WcWWj 
 Tìm hiểu Máy In EPSON R230 TruyêƦn mƣƥ c liên tuƥ c: 

 http://goo.gl/EVfw  http://goo.gl/xoIi 
 HƢƠƧNG DẪN DOWNLOAD VAƦ  CAƦI ĐĂƥ T PS CS5  

http://goo.gl/zzY1T 
 ACTIONS 15 BÀI VIẾT CỦA ÚT BỈNH (11,94 MB): 

http://goo.gl/8Rgwl 

 File DOC:http://goo.gl/RG9km  
 File PDF:http://goo.gl/DOh6F 
 Video: http://tinyurl.com/utbinh471 

http://goo.gl/TC5o 
http://www.youtube.com/watch?v=XaDWr5yhc98 

 Download aƤ nh “goc3x4” đêƤ  thƣƥ c tâƥ p 
http://goo.gl/C5dLl 

 Download aƤ nh utbinh3x4 để thực tập 

http://goo.gl/8nyxn 
 Tạo Dỉa Video Hƣớng dẫn thực hành Photoshop 

http://goo.gl/vQbTu 
 Download File Actions “tao9anh3x4.atn” http://goo.gl/ANugG 
 File aƤ nh 4x6 của bạn hoặc ảnh Brigitte Bardot tại 

http://goo.gl/WcWWj 
 Tìm hiểu Máy In EPSON R230 TruyêƦn mƣƥ c liên tuƥ c 

http://goo.gl/EVfw  http://goo.gl/xoIi 
100 KiêƤ u chƣ̃ đeƥ p: 
http://goo.gl/Mp0L0 

900 actions photoshop 
http://goo.gl/d3McR 
50 Actions hay để chỉnh màu cho ảnh chân dung 

http://goo.gl/vNAjx 
800 Actions fonts chữ 

http://goo.gl/C7vu9 
      Học Photoshop CS5 băƦng Video : http://www.hocps.com/ 
 

Cách Tạo Dỉa Video dạy Photoshop KS Dƣơng Trung Hiếu 
 

Cách Tạo Dỉa Video dạy Photoshop: http://tinyurl.com/utbinh 465 
Cách Tạo Dỉa Video dạy Photoshop JPEG: http://tinyurl.com/utbinh 466 
Cách Tạo Dỉa Video dạy Photoshop Dạng PDF: http://tinyurl.com/utbinh 467 

Cách Tạo Dỉa Video dạy Photoshop Dạng HTM: http://tinyurl.com/utbinh 468 
Cách Tạo Dỉa Video dạy Photoshop Xem Video: http://tinyurl.com/utbinh 469 
Links tôƤ ng hơƥ p caƧc nôƥ i dung Photoshop CS5 của Út Bỉnh: http://tinyurl.com/utbinh 470 

E-Book Photoshop CS5 Dạng DOC (6,67 MB): http://goo.gl/eBKDW 
E-Book Photoshop CS5 Dạng PDF(6 MB): http://goo.gl/ZgphX 

Trang Forum HaƤ i PhoƦng IT: http://goo.gl/1HKAK 

http://goo.gl/bbcZJ
http://goo.gl/tLzpr
http://www.youtube.com/watch?v=XaDWr5yhc98
http://goo.gl/C5dLl
http://goo.gl/8nyxn
http://goo.gl/vQbTu
http://goo.gl/ANugG
http://goo.gl/WcWWj
http://goo.gl/EVfw
http://goo.gl/xoIi
http://goo.gl/zzY1T
http://goo.gl/8Rgwl
http://goo.gl/RG9km
http://goo.gl/DOh6F(pdf)
http://tinyurl.com/utbinh471
http://goo.gl/TC5o
http://www.youtube.com/watch?v=XaDWr5yhc98
http://goo.gl/C5dLl
http://goo.gl/8nyxn
http://goo.gl/vQbTu
http://goo.gl/ANugG
http://goo.gl/WcWWj
http://goo.gl/EVfw
http://goo.gl/xoIi
http://goo.gl/Mp0L0
http://goo.gl/d3McR
http://goo.gl/vNAjx
http://goo.gl/C7vu9
http://www.hocps.com/
http://tinyurl.com/utbinh%20465
http://tinyurl.com/utbinh%20466
http://tinyurl.com/utbinh%20467
http://tinyurl.com/utbinh%20468
http://tinyurl.com/utbinh%20469
http://tinyurl.com/utbinh%20470
http://goo.gl/eBKDW
http://goo.gl/ZgphX
http://goo.gl/1HKAK
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Trang cuƤ a  Admin IBM 32 dỉa KS Hiếu: http://goo.gl/klWAx 
Chƣơng Tri Ʀnh Internet Download Manager 5.18 (4,24 MB): http://goo.gl/AM3JV 

Links Trang Web HaiPhongIt: http://goo.gl/RIIIl 
Chƣơng Tri Ʀnh HJSPlit nôƧi caƧc Files ISO (280 KB):http://hjsplit.en.softonic.com/ 
Chƣơng Tri Ʀnh Ghi DiƤ a Nero 7511 (115,5 MB): http://goo.gl/RJ8OI 

 
 
 

TÌM HIỂU VỀ PHOTOSHOP 
 
NguôƦn: http://goo.gl/3ScKz 
 

Adobe Photoshop (thƣờng đƣợc gọi là Photoshop) là một phần mềm đồ họa chuyên dụng của 
hãng Adobe Systems ra đời vào năm 1988 trên hệ máy Macintosh. Photoshop đƣợc đánh giá là phần 

mềm dẫn đầu thị trƣờng về sửa ảnh bitmap và đƣợc coi là chuẩn cho các ngành liên quan tới chỉnh 
sửa ảnh. Từ phiên bản Photoshop 7.0 ra đời năm 2002, Photoshop đã làm lên một cuộc cách mạng 
về ảnh bitmap. Phiên bản mới nhất hiện nay là Adobe Photoshop CS5. 

Ngoài khả năng chính là chỉnh sửa ảnh cho các ấn phẩm, Photoshop còn đƣợc sử dụng trong các 
hoạt động nhƣ thiết kế trang web, vẽ các loại tranh (matte painting và nhiều thể loại khác), vẽ 

texture cho các chƣơng trình 3D... gần nhƣ là mọi hoạt động liên quan đến ảnh bitmap. 

Adobe Photoshop có khả năng tƣơng thích với hầu hết các chƣơng trình đồ họa khác của Adobe nhƣ 
Adobe Illustrator, Adobe Premiere, After After Effects và Adobe Encore. 

Lịch sử 

Từ thuở niên thiếu, hai anh em Thomas Knoll và John Knoll đã thành thạo kỹ thuật xử lý ảnh trong 
buồng tối, do ảnh hƣởng bởi niềm đam mê nhiếp ảnh của ngƣời cha - Glenn Knoll, giáo sƣ Đại học 

Michigan. Hai cậu Thomas và John cũng yêu thích việc lập trình trên máy tính Apple II. 

Xúc cảm từ nghệ thuật nhiếp ảnh tác động đến việc chọn nghề của Thomas và John. Thomas theo 

ngành khoa học máy tính tại Đại học Michigan, luôn quan tâm đến những giải thuật xử lý ảnh (thu 
nhận từ máy quét). Khác với ngƣời anh, John tìm đến Đại học Southern California, theo ngành điện 
ảnh. 

Năm 1987, trong khi Thomas đang thực hiện luận án tiến sĩ về xử lý ảnh, John tốt nghiệp đại học và 
tìm đƣợc việc làm "trong mơ" tại Công ty ILM (Industrial Light and Magic), nơi chuyên thực hiện kỹ 

xảo hình ảnh cho các xƣởng phim ở Hollywood. 

Khi thực hiện luận án, Thomas thử nghiệm nhiều giải thuật xử lý ảnh trên máy tính Mac (Macintosh). 
Máy Mac vào lúc đó dùng màn hình đơn sắc, khiến anh phải nghiên cứu giải thuật giả lập sắc độ xám 

để hiển thị đƣợc ảnh "đen trắng" trên màn hình. Thomas đặt tên cho tập hợp các chƣơng trình nhỏ 
của mình là Display. 

Trong một lần về thăm nhà ở Michigan, John nhận thấy Display có nhiều nét giống với phần mềm xử 

lý ảnh mà anh thƣờng dùng trên máy tính Pixar đắt tiền tại ILM. Không thể đứng ngoài "cuộc chơi", 
John tham gia vào việc phát triển phần mềm Display, tự tạo thêm hoặc đề nghị Thomas tạo thêm các 

chức năng mới cho Display giúp ích cho việc làm phim ở ILM. 

http://goo.gl/klWAx
http://goo.gl/AM3JV
http://goo.gl/RIIIl
http://hjsplit.en.softonic.com/
http://goo.gl/RJ8OI
http://goo.gl/3ScKz
http://vi.wikipedia.org/wiki/Ph%E1%BA%A7n_m%E1%BB%81m
http://vi.wikipedia.org/wiki/Adobe_Systems
http://vi.wikipedia.org/wiki/Macintosh
http://vi.wikipedia.org/wiki/Bitmap
http://vi.wikipedia.org/w/index.php?title=Adobe_Illustrator&action=edit&redlink=1
http://vi.wikipedia.org/w/index.php?title=Adobe_Premiere&action=edit&redlink=1
http://vi.wikipedia.org/w/index.php?title=After_After_Effects&action=edit&redlink=1
http://vi.wikipedia.org/w/index.php?title=Adobe_Encore&action=edit&redlink=1
http://vi.wikipedia.org/wiki/Hollywood
http://vi.wikipedia.org/wiki/Macintosh
http://vi.wikipedia.org/wiki/Macintosh
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John đề nghị Thomas đổi tên Display đơn giản thành tên khác, hấp dẫn hơn. Lúc đầu cả hai chọn tên 
ImagePro, sau đổi thành PhotoLab, cuối cùng nhất trí chọn tên PhotoShop, một tên chƣa ai dùng. 

Tuy nhiên, khi John đề nghị thƣơng mại hóa PhotoShop, Thomas lại e ngại vì không muốn nhảy vào 
cuộc kinh doanh trong lúc luận án còn dở dang. 

Tin chắc vào triển vọng của PhotoShop, khi trở lại làm việc tại California, John tìm cách liên lạc với 

nhiều công ty ở vùng Silicon Valley để tìm kênh phân phối chuyên nghiệp cho sản phẩm "cây nhà lá 
vƣờn" của mình. Vừa thúc giục Thomas tiếp tục bổ sung chức năng cho PhotoShop, John vừa biên 
soạn tài liệu hƣớng dẫn sử dụng. Sau khi gửi lại tài liệu cùng đĩa mềm PhotoShop tại nhiều công ty, 

chờ thẩm định và nhận đƣợc nhiều lời từ chối, cuối cùng John cũng đạt đƣợc ý nguyện. Công ty 
Adobe chấp thuận phân phối PhotoShop với tên gọi Adobe Photoshop (Shop đƣợc sửa thành shop). 

Để hoàn thiện Photoshop trƣớc khi phát hành, hai chuyên viên của Adobe - Steve Guttman và Russell 
Brown - đề nghị với John nhiều sửa đổi về cấu trúc và giao diện của phần mềm. John truyền đạt lại 
cho Thomas ở Michigan qua điện thoại. Cứ vài ngày, Thomas lại ra bƣu điện, gửi cấp tốc đĩa mềm 

chứa chƣơng trình vừa chỉnh sửa cho Adobe (lúc đó chƣa phải là thời đại Internet). 

Ngày 19/2/1990, phần mềm Adobe Photoshop 1.0 dùng cho máy Mac, có dung lƣợng 728 KB, đƣợc 

phát hành ở dạng đóng gói, gồm một đĩa mềm và tài liệu hƣớng dẫn. 

Từ năm 1992, khi vai trò chuyên nghiệp của Photoshop đã đƣợc xác lập, các phần mềm khác có chức 
năng xử lý ảnh tƣơng tự Photoshop (Photo-Paint, Paint Shop Pro tại Mỹ, Nuances tại Pháp,...) mới 

xuất hiện. 

Đến năm 1995, tập đoàn Adobe mua bản quyền Photoshop từ anh em Knoll. 

Kể từ năm 2003, khi Adobe bắt đầu gói tất cả công cụ Web và in ấn (bao gồm Photoshop) vào một 

gói ứng dụng có tên là Creative Suite, hãng này thƣờng xuyên nâng cấp bộ công cụ này dựa trên ý 
kiến đóng góp của cộng đồng, tập trung chủ yếu vào dịch vụ trực tuyến và phân tích web. 

 Photoshop Creative Suite 4 (64-bit): chỉ dành cho ngƣời dùng Windows Vista. Đến 
Photoshop Creative Suite 5 ngƣời dùng Mac mới đƣợc dùng phiên bản 64-bit.:[1] 

 Photoshop Creative Suite 5 (phiên bản 12.0): với 2 bản Standard và Extended nằm trong 

bộ Creative Suite 5, đƣợc phát hành ngày 12 tháng 4 năm 2010. 

PHOTOSHOP DÂƧU ÂƧN 20 NĂM 

Tối ngày 18/2/2010, lễ kỷ niệm "20 năm Photoshop" diễn ra tại nhà hát lớn của San 
Francisco (bang California, Mỹ), do Hiệp hội Chuyên viên Photoshop (National Association 

of Photoshop Professionals - NAPP) và Công ty Adobe Systems phối hợp tổ chức. Tính từ 
ngày 19/2/1990 - ngày phát hành chính thức phần mềm Adobe Photoshop 1.0, 
Photoshop đƣợc xem là tròn 20 tuổi. Adobe quyết định tiến hành nhiều hoạt động chào 

mừng tuổi đôi mƣơi của Photoshop trong suốt năm 
  
2010. Cho dù không có những hoạt động quảng bá Photoshop mạnh mẽ của Công ty Adobe trong 
năm 2010, đối với hàng trăm triệu ngƣời dùng Photoshop trên khắp thế giới, Photoshop luôn là từ 
ngữ ghi dấu ấn sâu đậm trong tiềm thức. Từ photoshop (không viết hoa) đã trở thành một động từ 

quen thuộc diễn đạt việc xử lý ảnh, cũng không hiếm khi đƣợc dùng nhƣ một tính từ (photoshopped 
hoặc gọn hơn, shopped) để nói về những bức hình tƣởng là ảnh chụp từ thực tế nhƣng đã qua "chế 

biến", tạo nên những chi tiết không có thực. Cùng với lễ kỷ niệm tại Mỹ, hoạt động chào mừng "20 
năm Photoshop" diễn ra tại nhiều nƣớc (Đức, Pháp, Nhật, Ấn, Singapore,...), phần lớn do cộng đồng 
ngƣời dùng Photoshop tự tổ chức, dƣới hình thức cuộc thi xử lý ảnh hoặc cuộc gặp gỡ của những 

"cao thủ Photoshop" nhằm trình bày những thủ thuật xử lý ảnh thú vị nhất. Trên nhiều trang blog 
hoặc trong dòng tweet cuồn cuộn, những lời cảm ơn tận đáy lòng đƣợc bày tỏ từ những ngƣời kiếm 

http://vi.wikipedia.org/wiki/Adobe_Systems
http://vi.wikipedia.org/wiki/Adobe_Systems
http://vi.wikipedia.org/w/index.php?title=Creative_Suite&action=edit&redlink=1
http://vi.wikipedia.org/wiki/World_Wide_Web
http://vi.wikipedia.org/wiki/Windows_Vista
http://vi.wikipedia.org/wiki/Adobe_Photoshop#cite_note-0
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sống bằng Photoshop, hƣớng đến những ngƣời đã tạo nên, đã phát triển Photoshop thành công cụ 
tinh tế nhƣ ngày nay. "Màn hình chào" (splash screen) của các phiên bản Adobe Photoshop đầu tiên 

ghi tên bốn ngƣời tham gia vào việc xây dựng sản phẩm trong hai năm 1989-1990: Thomas Knoll, 
John Knoll, Steve Guttman và Russell Brown. Câu chuyện anh em Knoll Từ thuở niên thiếu, hai 
anh em Thomas Knoll và John Knoll đã thành thạo kỹ thuật xử lý ảnh trong buồng tối, do ảnh hƣởng 

bởi niềm đam mê nhiếp ảnh của ngƣời cha - Glenn Knoll, giáo sƣ Đại học Michigan. Hai cậu Thomas 
và John cũng yêu thích việc lập trình trên máy tính Apple II. Xúc cảm từ nghệ thuật nhiếp ảnh tác 
động đến việc chọn nghề của Thomas và John. Thomas theo ngành khoa học máy tính tại Đại học 

Michigan, luôn quan tâm đến những giải thuật xử lý ảnh (thu nhận từ máy quét). Khác với ngƣời anh, 
John tìm đến Đại học Southern California, theo ngành điện ảnh. Vào năm 1987, trong khi Thomas 

đang thực hiện luận án tiến sĩ về xử lý ảnh, John tốt nghiệp đại học và tìm đƣợc việc làm "trong mơ" 
tại Công ty ILM (Industrial Light and Magic), nơi chuyên thực hiện kỹ xảo hình ảnh cho các xƣởng 
phim ở Hollywood. Khi thực hiện luận án, Thomas thử nghiệm nhiều giải thuật xử lý ảnh trên máy 

tính Mac (Macintosh). Máy Mac vào lúc đó dùng màn hình đơn sắc, khiến anh phải nghiên cứu giải 
thuật giả lập sắc độ xám để hiển thị đƣợc ảnh "đen trắng" trên màn hình. Thomas đặt tên cho tập 

hợp các chƣơng trình nhỏ của mình là Display.  

 

 
Thomas Knoll và John Knoll (1990) 

Trong một lần về thăm nhà ở Michigan, John nhận thấy Display có nhiều nét giống với phần mềm xử 
lý ảnh mà anh thƣờng dùng trên máy tính Pixar đắt tiền tại ILM. Không thể đứng ngoài "cuộc chơi", 
John tham gia vào việc phát triển phần mềm Display, tự tạo thêm hoặc đề nghị Thomas tạo thêm các 

chức năng mới cho Display giúp ích cho việc làm phim ở ILM. John đề nghị Thomas đổi tên Display 
đơn giản thành tên khác, hấp dẫn hơn. Lúc đầu cả hai chọn tên ImagePro, sau đổi thành PhotoLab, 

cuối cùng nhất trí chọn tên PhotoShop, một tên chƣa ai dùng. Tuy nhiên, khi John đề nghị thƣơng 
mại hóa PhotoShop, Thomas lại e ngại vì không muốn nhảy vào cuộc kinh doanh trong lúc luận án 
còn dở dang. Tin chắc vào triển vọng của PhotoShop, khi trở lại làm việc tại California, John tìm cách 

liên lạc với nhiều công ty ở vùng Silicon Valley để tìm kênh phân phối chuyên nghiệp cho sản phẩm 
"cây nhà lá vƣờn" của mình. Vừa thúc giục Thomas tiếp tục bổ sung chức năng cho PhotoShop, John 

vừa biên soạn tài liệu hƣớng dẫn sử dụng. Sau khi gửi lại tài liệu cùng đĩa mềm PhotoShop tại nhiều 
công ty, chờ thẩm định và nhận đƣợc nhiều... lời từ chối, cuối cùng John cũng đạt đƣợc ý nguyện. 
Công ty Adobe chấp thuận phân phối PhotoShop với tên gọi Adobe Photoshop (Shop đƣợc sửa thành 

shop). Để hoàn thiện Photoshop trƣớc khi phát hành, hai chuyên viên của Adobe - Steve Guttman và 
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Russell Brown - đề nghị với John nhiều sửa đổi về cấu trúc và giao diện của phần mềm. John truyền 
đạt lại cho Thomas ở Michigan qua điện thoại. Cứ vài ngày, Thomas lại ra bƣu điện, gửi cấp tốc đĩa 

mềm chứa chƣơng trình vừa chỉnh sửa cho Adobe (lúc đó chƣa phải là thời đại Internet). Ngày 
19/2/1990, phần mềm Adobe Photoshop 1.0 dùng cho máy Mac, có dung lƣợng 728 KB, đƣợc phát 
hành ở dạng đóng gói, gồm một đĩa mềm và tài liệu hƣớng dẫn. Đến năm 1995, Adobe mua đứt bản 

quyền Photoshop từ anh em Knoll.  

 

 
Từ trái qua: John Loiacono (Phó chủ tịch Adobe), Russell Brown (Giám đốc sáng tạo 
Adobe), Thomas Knoll, John Knoll, Kevin Connor (Giám đốc sản phẩm Photoshop) tại lễ 

kỷ niệm "20 năm Photoshop" (18/2/2010) 

Vì sao là Photoshop? Nhiều ngƣời vẫn nghĩ Photoshop là phần mềm xử lý ảnh đầu tiên. Nói cho 

đúng, Photoshop là phần mềm xử lý ảnh hoàn chỉnh đầu tiên trên máy tính cá nhân. Trƣớc 
Photoshop, phần mềm Realist trên máy Mac (sau đổi tên thành ImageStudio) có chức năng cắt ghép 
ảnh nhƣng chƣa đáp ứng đƣợc nhu cầu thiết yếu của những ngƣời yêu thích nhiếp ảnh: cải thiện 

chất lƣợng ảnh. Khi Photoshop xuất hiện trên máy Mac, máy PC mới chỉ có những phần mềm vẽ 
tranh, chƣa hề có chức năng xử lý ảnh. Không chỉ đi tiên phong với nhiều chức năng đồ họa, Mac 

còn là loại máy tính cá nhân đầu tiên dùng màn hình màu, đủ sức hiển thị trung thực ảnh màu (John 
mua ngay máy Mac có màn hình màu cho Thomas khi loại máy "đời mới" ấy vừa xuất hiện trên thị 
trƣờng). Vì vậy, trong một thời gian dài, máy Mac là "công cụ chuẩn" cho giới thiết kế đồ họa chuyên 

nghiệp. Gắn bó với máy Mac, Photoshop cũng trở thành "công cụ chuẩn". Thực ra, từ trƣớc khi đƣợc 
phát hành rộng rãi bởi Adobe, PhotoShop đã chiếm đƣợc cảm tình của giới làm phim chuyên nghiệp. 
John Knoll đã dùng PhotoShop để xử lý từng khung hình trong một số cảnh của phim Abyss (phim 

của đạo diễn James Cameron). PhotoShop giúp tách nhân vật khỏi màn xanh, đặt vào hậu cảnh tùy 
ý, chỉnh sửa ánh sáng của từng khung hình trong cảnh và tạo ra các hiệu ứng độc đáo. Giải Oscar 

"Kỹ xảo hay nhất" (Best Visual Effects) dành cho phim Abyss trong năm 1990 chính là "chiến công" 
của PhotoShop. Do PhotoShop quá gắn bó với điện ảnh, một trong những đề nghị đầu tiên của 
Adobe với John Knoll là... loại bỏ những chức năng trong PhotoShop chỉ thích hợp với ngƣời làm 

phim, không đắc dụng cho ngƣời dùng bình thƣờng. Điều này khiến John Knoll phải chuyển những 
chức năng yêu thích của mình trong PhotoShop thành chức năng cắm thêm (plug-in). Cơ cấu này mở 

đƣờng cho sự phát triển vô cùng phong phú của những plug-in, tạo nên thế mạnh đặc thù cho 
Photoshop. Từ năm 1992, khi vai trò chuyên nghiệp của Photoshop đã đƣợc xác lập, các phần mềm 
khác có chức năng xử lý ảnh tƣơng tự Photoshop (Photo-Paint, Paint Shop Pro tại Mỹ, Nuances tại 

Pháp,...) mới xuất hiện. Vị thế tiên phong của Photoshop đƣợc giữ vững nhờ những sáng tạo không 
ngừng của nhóm phát triển Photoshop tại Adobe. Mỗi phiên bản Photoshop mới đều có những chức 
năng mới thu hút ngƣời dùng. Sự xuất hiện khái niệm lớp (layer) trong Photoshop 3.0 (1994) là đột 

phá quan trọng. Dùng nhiều lớp trong Photoshop, ngƣời dùng không chỉ tạo ra nhiều hình chồng lên 
nhau mà còn có thể kết hợp từng điểm ảnh (pixel) trên nhiều lớp theo nhiều cách để tạo ra những 

hiệu ứng lạ mắt. Lớp bên trên có thể "chỉnh sửa" lớp bên dƣới nhƣng lớp bên dƣới không thay đổi 
(hình gốc đƣợc giữ nguyên).  
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Phiên bản Photoshop 1.0.7 đƣợc tái tạo trên iPhone, do Russell Brown (Giám đốc sáng 
tạo Adobe) giới thiệu tại lễ kỷ niệm "20 năm Photoshop" 

Với phiên bản Photoshop CS5 sắp tới, Adobe không chỉ khai thác triệt để những giải thuật nhận dạng 
nhằm tạo ra các chức năng thông minh trong việc tách biệt hình dạng trong ảnh (chức năng Patch 
Match, Spot Healing,...), mà còn cố gắng đáp ứng tinh tế nhu cầu vẽ tranh nghệ thuật để "sánh vai" 

với Corel Painter. Dù sao, xử lý ảnh luôn là mục tiêu quan trọng nhất của Photoshop. Trở nên đồng 
nhất với khái niệm xử lý ảnh, Photoshop góp phần chủ yếu vào việc loại bỏ tính xác thực đƣơng 
nhiên của ảnh chụp. Ngày nay, bức ảnh chụp không còn giá trị minh chứng mạnh mẽ nhƣ đã từng có 

trong quá khứ. Mọi ngƣời bắt đầu hiểu rằng bức ảnh chụp đầy tính thuyết phục trƣớc mắt họ hoàn 
toàn có thể là sản phẩm của Photoshop! AN NHIÊN 

 

PHOTOSHOP CS5 NHƢ̃NG TIƧNH NĂNG MƠƧ I 

NguôƦn: http://goo.gl/NUVvV 

Giới thiết kế đồ họa đang rất háo hức chờ đợi đƣợc chạm tay vào phiên bản Adobe Photoshop CS5 

với các chức năng biến tấu ảnh rất đặc sắc.  
Với Photoshop CS5, Adobe mang đến hàng loạt tính năng mới song song với việc nâng cấp các tính 
năng cũ. Ngoài phiên bản chuẩn Photoshop CS5, Adobe còn giới thiệu phiên bản mở rộng Photoshop 

CS5 Extended.  
 
Giao diện thân thiện và tiết kiệm không gian 

 
Giao diện của Photoshop CS5 có chút thay đổi nhỏ nhằm năng cao hiệu suất sử dụng, mặc dù vẫn 

giữ đƣợc vẻ thân thiện quen thuộc. Chẳng hạn, Workspace sẽ không còn bị “chôn vùi” dƣới menu 
Windows xổ xuống mà luôn lập tức có mặt ở phía trên màn hình, bên phải Ribbon Bar.  
 

http://goo.gl/NUVvV
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Ngoài ra, nếu bạn có thay đổi trên bất kỳ Workspace nào (chẳng hạn Photography), sau đó chuyển 
sang một Workspace khác (nhƣ Painting), khi trở lại Photography các thay đổi này vẫn sẽ còn 

nguyên. 
 
Thay đổi đáng kể nhất và cũng đƣợc coi là điểm cải tiến của thế hệ CS5 là ở Mini-Bridge, một trong 

số các điểm mới mẻ mà Adobe mới bổ sung, cho phép bạn truy cập vào tất cả các tập tin ảnh của 
mình mà không phải tạm thời ngừng thao tác trên Photoshop.  
 

Ngoài ra, bạn cũng có thể chọn hàng loạt cách hiển thị khác nhau, phụ thuộc thông tin bạn muốn 
nhận, từ dạng ảnh hiển thị Thumbnails, As Filmstrip đến dạng chi tiết hơn gồm Details và List.  

 
Trên giao diện của Photoshop CS5 còn một điểm chú ý khác là sự xuất hiện theo các các biểu tƣợng 
toolbox theo hình thức thiết kế mới khác với trƣớc.  

 
Bƣớc tiến Camera RAW 

 
Một trong số những điểm thay đổi quan trọng nhất của phiên bản CS5 là thuật toán giảm nhiễu mới 
ở Camera RAW 6.  

 
Camera RAW 6 là một plugin mới vốn cũng sẽ có mặt trên Lightroom 3, hỗ trợ hơn 275 loại camera. 
Khả năng mạnh mẽ nhất của Camera RAW là giảm nhiễu, cho phép bạn xóa ảnh đƣợc chụp ở các 

mức ISO cao nhất.  

 
 
Khả năng xử lý điểm ảnh của Photoshop CS5 nhanh và chính xác hơn, nhất là với các khu 

vực phức tạp nhƣ tóc, quần áo - Ảnh Macworld 
 
Dẫu vậy, Camera RAW 6 và Lightroom 3 sẽ tƣơng thích tốt hơn khi cả hai cùng sử dụng thuật toán 

chuyển đổi chung định dạng RAW. Điều đó có nghĩa bạn sẽ không phải gặp tình trạng xung đột, buộc 
phải lựa chọn giữa 2 giải pháp trên.  

 
Điểm đáng lƣu ý là Camera Raw 6 sẽ không hỗ trợ những ai đang sử dụng các phiên bản trƣớc thế 
hệ CS5. 

 
Mặt nạ thông minh hơn 

 
Phiên bản Photoshop thế hệ mới còn cho phép ngƣời dùng thao tác hiệu quả hơn với thuộc tính Mặt 
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nạ (Masking) và Lựa chọn vùng (Selection). 
 

Hộp thoại chọn vùng Refine Edge đã đƣợc thiết kế lại, cho phép chọn nhiều vùng chính xác hơn, 
đặc biệt là các vùng giao nhau giữa hai đối tƣợng vốn trƣớc đây tƣơng đối khó thao tác, nhƣ tóc hay 
quần áo.  

 
Ngoài ra, kết hợp các công cụ Refine Radius, “chổi” Erase Refinements và chế độ phân tích 
đƣờng viền Smart Radius, thao tác chọn vùng ở các đối tƣợng phức tạp sẽ đơn giản hơn nhiều. 

Phiên bản CS5 cũng có sẵn lựa chọn Color Decontaminant, giúp ngƣời dùng dễ dàng loại bỏ 
background thừa, không phù hợp với mặt nạ đang tinh chỉnh.  

 
Refine Edge cũng sẽ tiết kiệm thời gian cho ngƣời dùng, đáng tiếc là thiếu hộp thoại Undo/Redo mà 
chỉ có Reset, giúp bạn trở lại với thao tác trƣớc. Khi lƣu lại mặt nạ, Refine Edge đƣa ra khá nhiều lựa 

chọn hữu ích nhƣ Layer Mask, New Layer, New Layer với Layer Mask, New Document, hoặc New 
Document với Layer Mask.  

 
Một điểm thú vị cần phải kể tới là Refine Edge tƣơng tác với Smart Objects và điều này có nghĩa 
bạn dễ dàng trở lại Camera RAW để thao tác lại tùy chỉnh của mình, trong khi vẫn giữ lại những gì đã 

làm cùng mặt nạ. 
 
Công cụ tẩy xóa tuyệt vời 

 
Nhiều ngƣời dùng sẽ coi Content Aware Fill là tính năng mới hàng đầu của phiên bản Photoshop 

CS5. Đây là công cụ tẩy xóa tuyệt vời khi tƣơng tác với Spot Healing Brush (chữa điểm ảnh) và có 
một lựa chọn ở công cụ Fill.  
 

Theo nhận định của một số chuyên gia Photoshop, nhờ vào cơ chế gần nhƣ hoàn toàn tự động, CS5 
giúp bạn xử lý ảnh trong giây lát mà trƣớc đây một ngƣời có kỹ thuật cao phải tiêu tốn vài giờ. 

 
Công cụ sáng tạo thú vị 
 

Adobe đã cải tiến Paint Brushes (trong đó có công cụ Clone). Mixer Brush mới tƣơng tác tốt với màu 
sắc của bức ảnh. Bạn có thể chọn làm việc với chế độ vẽ khô hoặc ƣớt (ảo).  

 
Tất cả các Brush đều hỗ trợ chế độ xem trƣớc dƣới dạng giả lập 3D nên hình ảnh trung thực, chính 
xác. Nhờ vào Mixer Brush, ngƣời dùng có thể pha màu giống nhƣ một họa sĩ thực thụ, khi họ dễ 

dàng kiểm soát độ “ƣớt” của màu sắc cùng với tỉ lệ pha trộn. 
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Khả năng xử lý của Mixer Brush và Bristle Tips trên Photoshop CS5 - hai công cụ thú vị 

giúp ngƣời dùng có đƣợc những kiệt tác nhƣ ý - Ảnh Macworld 
 
 

 
 

Công cụ Puppet Warp mới của Photoshop trƣớc và sau khi xử lý - Ảnh Wired 
 

Puppet Warp mới mang đến một công cụ sáng tạo khác. Bạn có thể đẩy và kéo các yếu tố trong ảnh. 
Bạn dễ dàng kiểm soát các điểm ảnh, sau đó kéo và thả theo hình dáng mong muốn. 
 

"Hàng tá" cải tiến 
 

Bạn có thể xác lập các Layer Effects mặc định, theo sở thích tùy chọn riêng. CS5 cũng hỗ trợ chế 
độ lƣu dữ liệu mới, tiện ích hơn khi ngƣời dùng có thể tùy chọn lƣu lại ở thƣ mục gần đây nhất đã 
lƣu tập tin. Họ sẽ không còn phải lóng ngóng tìm lại thƣ mục trƣớc đây mỗi khi nhấn vào Save As. 

 
Phiên bản CS5 cũng “tăng lực” khả năng xử lý 3D, nhờ vào “nhánh” Photoshop Extended. Photoshop 
Extended gồm hộp thoại Repousse mới, giúp ích việc xử lý 3D. Bạn cũng sẽ thấy phiên bản 

Extended đã đƣợc cải tiến đáng kể so các thế hệ tiền nhiệm và phần nào đủ đáp ứng nhu cầu xử lý 
3D. 
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Hộp thoại Repoussé mới giúp dễ dàng tạo và xử lý các hiệu ứng 3D 
 

Photoshop CS5 cho phép bạn chọn nhiều layer một lúc, xử lý đồng thời. Ngƣời dùng còn có thể tạo 
riêng cho mình những mẫu layer riêng. Thế hệ CS5 hỗ trợ chế độ lƣu hình ảnh 16-bit dạng JPG mà 
không cần phải chuyển về 8-bit nhƣ ở phiên bản Photoshop CS4.  

 
Photoshop CS5 bản chuẩn có giá 699 USD. Bản Extended có giá 999 USD. 
 

Nhờ vào việc tích hợp, hỗ trợ điều chỉnh độ mờ của các lớp (Adjusting Opacity), ngƣời dùng có thể 
tiết kiệm đáng kể thời gian. Ngoài ra nhờ vào thuật toán mới, họ có thể lƣu nhiều ảnh với chỉ một 

câu lệnh. 
 
Adobe cũng sử dụng các công nghệ tiên tiến để trang bị cho sản phẩm, trong đó có tính năng tăng 

tốc GPU, khả năng xử lý nhanh hơn khi hỗ trợ môi truờng 64-bit, cải tiến bộ máy OpenGL. Phiên bản 
Photoshop mới cũng giúp ngƣời dùng quản lý các nội dung đa phƣơng tiện tốt hơn và Web Gallery 

cũng đã tích hợp với Adobe Bridge CS5 cùng với sự ra đời của Adobe Mini Bridge mới. 
 
(Theo NHẬT VƢƠNG, TUOITRE.COM.VN) 
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